Excavation Iin sand

This tutorial describes the construction of an excavation pit in soft clay and sand layers. The pit is a relatively
small excavation of 12 by 20 m, excavated to a depth of 6.5 m below the surface. Struts, walings and ground
anchors are used to prevent the pit from collapsing. After the full excavation, an additional surface load is added
on one side of the pit.

Objectives

Using the Hardening Soil model

Modelling of ground anchors

Using interface features

Defining over-consolidation ratio (OCR)

Prestressing a ground anchor

Changing water conditions

Selection of stress points to generate stress/strain curves
Viewing plastic points

Geometry

The proposed geometry for this exercise is 80 m wide and 50 m long. The excavation pit is placed in the center of
the geometry.
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Figure 22: Top view of the excavation pit

The figure below shows a cross section of the excavation pit with the soil layers. The clay layer is considered to

be impermeable.
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Figure 23: Cross section of the excavation pit with the soil layers

2.1 Create a new project

To create the geometry model, follow these steps:

1. Start a new project.
2. Enter an appropriate title for the project.
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3. Define the limits for the soil contour as

a. Xpin = 0.0 and x4 = 80.0,
b. Ymin = 0.0 and y,.x = 50.0.

2.2 Define the soil stratigraphy

In order to define the soil layers, a borehole needs to be added and material properties must be assigned. As all
soil layers are horizontal, only a single borehole is needed.

1.

The Modify soil layers window pops up.
2. Add 4 layers with bottom levels at -1, -9.5, -11, -20.
3. Set the Head in the borehole column to -4 m.

2.3 Create and assign the material data sets

Click the Create borehole button . and create a borehole at (0 0 0).

A number of materials need to be defined for the different soil layers. The material properties are shown in the

table belowLinear Elastic model.

Table 5: Material properties for the soil layers

Parameter Name Fill Sand Soft Clay Unit
General
Material model Model Harde-ning Harde.ning Harde.ning i
Soil Soil Soil
Drainage type Type Drained Drained Undrained A -
Unit weight above phreatic level Yunsat 16.0 17.0 16.0 kN/m?3
Unit weight below phreatic level Ysat 20.0 20.0 17.0 kN/m3
Parameters
Secant stiffness for CD triaxial test Esy"d 2.2-10% 4.3-10% 2.0-103 kN/m?
Tangent oedometer stiffness E i 2.2:10% 2.2:10% 2.0-103 kN/m?
Unloading/reloading stiffness E,¢ 6.6-10% 1.29-10° 1.0-10* kN/m?
z’tci);/}/rtleé’sfsor stress level dependency of m 05 05 1.0 )
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Parameter Name Fill Sand Soft Clay Unit
Cohesion C'ref 1 1 5 kN/m?
Friction angle Q' 30.0 34.0 25 °
Dilatancy angle Y 0.0 4.0 0.0 °
Poisson's ratio Vir 0.2 0.2 0.2 -
Drainage type
Interface strength - Manual Manual Manual -
Interface reduction factor Rinter 0.65 0.7 0.5 -
Initial
Ky determination - Automatic Automatic Automatic -
Lateral earth pressure coefficient Ky 0.5000 0.4408 0.7411 -
Over-consolidation ratio OCR 1.0 1.0 1.5 -
Pre-overburden pressure POP 0.0 0.0 0.0 -

PLAXIS

Click the Materials button in the side toolbar.

The Material sets window pops up.

Create a new data set under Soil and interfaces set type.

Identify the new data set as Fill.

From the Material model drop-down menu, select Hardening Soil model. In contrast with the Mohr-Coulomb
model, the Hardening Soil model takes into account the difference in stiffness between virgin-loading and
unloading-reloading. For a detailed description of the Hardening Soil model, see the Material Models Manual.

Define the saturated and unsaturated unit weights according to Table 5 (on page 40).

. In the Parameters tabsheet, enter values for Es"f, Eooq"f, E,,"¢f, m, ¢'ref, @'rep, W and V', Note that Poisson's

ratio is an advanced parameter.

As no consolidation will be considered in this exercise, the permeability of the soil will not influence the
results. Therefore, the default values can be kept in the Flow parameters tabsheet.

. In the Interfaces tabsheet, select Manual in the Strength box and enter a value of 0.65 for the parameter

Rinter-
This parameter relates the strength of the interfaces to the strength of the soil, according to the equations:
Ci = RinterCsoil and tan@; = Ripertan@istang,

Hence, using the entered R;,¢-value gives a reduced interface friction and interface cohesion (adhesion)
compared to the friction angle and the cohesion in the adjacent soil.

Note:

¢ When the Rigid option is selected in the Strength drop-down, the interface has the same strength
properties as the soil (Riyter = 1.0).
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¢ Note that a value of Rjyer < 1.0, reduces the strength as well as the stiffness of the interface (for more

information see the Reference Manual).

9. In the Initial tabsheet, define the OCR-value according to Table 5 (on page 40).
10. Click OK to close the window.
11. After closing the Material sets window, click the OK button to close the Modify soil layers window.
12. In the Soil mode right-click the upper soil layer. Select Set material > Fill.
13. In the same way assign the Soft Clay material to the soil layer betweeny =-9.5 mand y =-11.0 m.

14. Assign the Sand material to the remaining two soil layers.

Note: The Tension cut-off option is activated by default at a value of 0 kN/m?. This option is found in the
Advanced options on the Parameters tabsheet of the Soil window. Here the Tension cut-off value can be
changed or the option can be deactivated entirely.

2.4 Define the structural elements

The creation of walings and struts, ground anchors, sheet pile walls and surface loads is described below.

2.4.1 Walings and Struts

The material properties for the structural elements are shown in the table below. These are needed for defining

the material in a later step.

Table 6: Material properties of waling and strut

Parameter Name Strut Waling Unit
Material type Type Elastic Elastic -
Young's modulus E 2.1-108 2.1-108 kN/m?
Unit weight Y 78.5 78.5 kN/m3
Cross section area A 0.007367 0.008682 m?

I, 5.073-10°° 3.66-10% m*
Moment of Inertia
I3 5.073-10°> 1.045-10* m*

1. Click the Structures tab to proceed with the input of structural elements in the Structures mode.

2,
“J Create a surface between (30200),(30320),(50320)and (50 200).

3.
m Extrude the surfacetoz=-1,z=-6.5and z=-11.
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10.

11.

12.

Right-click on the deepest created volume (between z = 0 and z = -11) and select Decompose into surfaces.

Delete the top surfaces (2 surfaces).
An extra surface is created as the volume is decomposed.

. Hide the excavation volumes (do not delete).

The eye button in the Model explorer and the Selection explorer trees can be used to hide parts of the model
and simplify the view. A hidden project entity is indicated by a closed eye.

Click the Create structure button [ﬁ .

N Create beams (walings) around the excavation circumference at level z=-1m. Press <Shift> and keep it
pressed while moving the mouse cursor in the -z-direction. Stop moving the mouse as the z-coordinate of the
mouse cursor is -1 in the cursor position indicator. Note that as you release <Shift>, the z-coordinate of the
cursor location does not change. This is an indication that you can draw only on the xy-plane located at z = -1.

. Clickon (3020-1),(3032-1),(5032-1),(5020-1), (30 20 -1) to draw the walings. Click on the right mouse

button to stop drawing walings.
=
S Create a beam (strut) between (35 20 -1) and (35 32 -1). Press <Esc> to end defining the strut.

Create data sets for the walings and struts according to Table 6 (on page 42) and assign the materials
accordingly.

LX)

- aCopy the strut into a total of three struts at x = 35 (existing), x = 40, and x = 45.

2.4.7 Ground anchors

The material properties for the structural elements are shown in the table below. These are needed for defining
the material in a later step.

Table 7: Material properties of the node-to-node anchors

Parameter Name Node-to-node anchor Unit
Material type Type Elastic -
Axial stiffness EA 6.5-10° kN

Table 8: Material properties of the embedded beams (grout body)

Parameter Name Grout Unit
Young's modulus E 3-107 kN/m?
Unit weight Y 24 kN/m3
Beam type - Predefined -
Predefined beam type - Massive circular beam -
Diameter - 0.14 m

PLAXIS

43

PLAXIS 3D - Tutorial Manual



Excavation in sand
Define the structural elements

Parameter Name Grout Unit
Axial skin resistance Type Linear -
Skin resistance at the top
of the embedded beam Tskin,start max 200 kN/m
Skin resistance at the
bottom of the embedded Tskin,end max 0.0 kN/m
beam
Base resistance Finax 0.0 kN

In PLAXIS 3D ground anchors can be modelled using the Node-to-node anchor and the Embedded beam options
as described in the following:

1.
" First the ungrouted part of the anchor is created using the Node-to-node anchor feature. Start creating a

10.

PLAXIS

node-to-node anchor by selecting the corresponding button in the options displayed as you click on the
Create structure button.

. Click on the command line and type 30 24 -1 21 24 -7.Press <Enter> and <Esc> to create the

ungrouted part of the first ground anchor.
Create a node-to-node anchor between the points (50 24 -1) and (59 24 -7).
%; The grouted part of the anchor is created using the Embedded beam option. Create embedded beams

between (21 24 -7) and (18 24 -9) and between (59 24 -7) and (62 24 -9). Set the Behaviour to Grout body
(for more information see the Reference Manual).

lil Create a data set for the embedded beam and a data set for the node-to-node anchor according to Table 7
(on page 43) and Table 8 (on page 43) respectively. Assign the data sets to the node-to-node anchors and to
the embedded beams.

Note: The colour indicating the material set assigned to the entities in project can be changed by clicking on
the Colour box of the selected material set and selecting a colour from the Colour part of the window.

. The remaining grouted anchors will be created by copying the defined grouted anchor. Click on the Select

button and click on all the elements composing both of the ground anchors keeping <Ctrl> pressed.
LX)

252 Use the Create array function to copy both ground anchors (2 embedded beams + 2 node-to-node
anchors) into a total of 4 complete ground anchors located at y = 24 and y = 28 by selection the 1D, iny
direction option in the Shape drop-down menu and define the Distance between columns as 4 m.

I:'-} Multi-select all parts of the ground anchors (8 entities in total). While all parts are selected and <Ctrl >
is pressed, right-click and select Group.

“" In the Model explorer tree, expand the Groups subtree by clicking on the (+) in front of the groups.
Click the Group_1 and rename it to GroundAnchors.

Note: The name of the entities in the project should not contain any space or special character except _
(underscore).
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2.4.3 Pile sheet walls and loads

The material properties for the structural elements are shown in the table below. These are needed for defining
the material in a later step.

Table 9: Material properties of pile sheet walls

Parameter Name Sheet pile wall Unit
Type of behaviour Type Elastic -
Isotropic - No -
Thickness d 0.379 m
Weight % 2.55 kN/m3
E; 1.46-107 kN/m?
Young's modulus
E, 7.3-10° kN/m?
Poisson's ratio Viz 0.0 -
Gz 7.3-10° kN/m?
Shear modulus Gy3 1.27-10° kN/m?
G3 3.82:10° kN/m?

To define the sheet pile walls and the corresponding interfaces, follow these steps:

1.

2.

PLAXIS

'\..'.-l.
I:\-,}. Select all four vertical surfaces created as the volume was decomposed. Keeping <Ctrl> pressed, right-
click and select the Create plate option from the appearing menu.

Create a data set for the sheet pile walls (plates) according to Table 9 (on page 45). Assign the data sets to
the four walls.

. As all the surfaces are selected, assign both positive and negative interfaces to them using the options in the

right mouse button menu.

Note: The term 'positive' or 'negative' for interfaces has no physical meaning. It only enables distinguishing
between interfaces at each side of a surface.

~ " In the Model explorer tree expand the Surfaces subtree, set AxisFunction to Manual and set Axis1, to
-1. Do this for all the pile wall surfaces.
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Note:

* Non-isotropic (different stiffness in two directions) sheet pile walls are defined. The local axis should
point in the correct direction (which defines which is the 'stiff' or the 'soft' direction). As the vertical
direction is generally the stiffest direction in sheet pile walls, local axis 1 shall point in the z-direction.

e The first local axis is indicated by a red arrow, the second local axis is indicated by a green arrow and the
third axis is indicated by a blue arrow. More information related to the local axes of plates is given in the
Reference Manual.

+44
#J Create a surface load defined by the points: (34 19 0), (41 19 0), (41 12 0), (34 12 0).

The geometry is now completely defined.

2.5 Generate the mesh

. Proceed to the Mesh mode.
. Select the surface representing the excavation. In the Selection explorer set the value of Coarseness factor

to 0.25.

. Set the element distribution to Coarse. Uncheck the box for Enhanced mesh refinements. Click the Generate

mesh button " to generate the mesh.

Note: The Enhanced mesh refinements are automatically used in mesh generation. More information is
available in the Reference Manual.

Click the View mesh button ‘-‘~x to view the mesh. Hide the soil in the model to view the embedded beams.

. Click on the Close tab to close the Output program and go back to the Mesh mode of the Input program.

2.6 Define the calculation

The calculation consists of 6 phases. The initial phase consists of the generation of the initial stresses using the
KO procedure. The next phase consists of the installation of the sheet piles and a first excavation. Then the
walings and struts will be installed. In phase 3, the ground anchors will be activated and prestressed. Further
excavation will be performed in the phase after that. The last phase will be the application of the additional load
next to the pit.

1.
2.

PLAXIS

Click on the Staged construction tab to proceed with definition of the calculation phases.

The initial phase has already been introduced. Keep its calculation type as KO procedure. Make sure all the
soil volumes are active and all the structural elements are inactive.

@ Add a new phase (Phase_1). The default values of the parameters will be used for this calculation phase.
Deactivate the first excavation volume (from z=0 to z=-1).

. In the Model explorer, activate all plates and interfaces by clicking on the checkbox in front of them.

The active elements in the project are indicated by a green check mark in the Model explorer

46 PLAXIS 3D - Tutorial Manual



Excavation in sand
Define the calculation

@ Add a new phase (Phase_2). The default values of the parameters will be used for this calculation phase.
In the Model explorer activate all the beams.

@ Add a new phase (Phase_3). The default values of the parameters will be used for this calculation phase.
In the Model explorer activate the GroundAnchors group.

© &N o

10. [
I:'-J' Select one of the node-to-node anchors.
11. __
= In the Selection explorer expand the node-to node anchor features.
12. Click on the Adjust prestress checkbox. Enter a prestress force of 200 kN.

Selection explorer (Phase_3)
=t @ [v] Line_8_1
Coarseness factor: 0,5000
=t @ [¥] NodeToModeAnchor _1_1
=1 Material: ModetonodeAnchor
Colour: H
Apply strength reduction: [_]
Adjust prestress:

F presyesst 200,0 kN

Figure 24: Node-to-node anchor in the Selection explorer
13. Do the same for all the other node-to-node anchors.

14. =
@ Add another phase (Phase_4). The default values of the parameters will be used for this calculation

phase.

15. [,
[:'-3' Select the soil volume to be excavated in this phase (between z=-1 and z=-6.5).

option from the drop-down menu.

16
+ .-
In the Selection explorer under WaterConditions feature, click on the Conditions and select the Dry

Selection explorer (Phase_4)
= EITJD BorehaoleVolume_2_Volume_2_Volume_3_1
Coarseness factor: 1,000
=t @[] Soil_2_Soil_5_Seil_7_1
=1 Material: Sand
Colour: O
Apply strength reduction:
= Ci_: Preconsolidation_2_1

= C_:D VolumeStrain_2_VolumeStrain_s_VolumeStrain_7_1

Apply: []
= C_:D WaterConditions_2_WaterConditions_6_WaterConditions_7_1
Conditions: Dry

Figure 25: Water conditions in the Selection explorer
17. Deactivate the volume to be excavated (between z =-1 and z = -6.5).
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18. Hide the soil and the plates around the excavation.

19. [~
[:'-3' Select the soil volume below the excavation (between z =-6.5 and z = -9.5).

20. In Selection explorer under WaterConditions feature, click Conditions and select Head from the drop-down
menu. Enter z,¢¢=-6.5 m.

21, [,
[:'-3' Select the soft clay volume below the excavation.

22. Setthe water conditions to Interpolate.

23. &= ) ) )
¥ preview this calculation phase.

24, |7
[ Click the Vertical cross section button in the Preview window and define the cross section by drawing a

line across the excavation.

Note: Hold <Shift> when drawing to get a straight line.

25. Select the pgteaqy Option from the Stresses menu.

26. |/)! Display the contour lines for steady pore pressure distribution. Make sure that the Legend > View option
is checked. The steady state pore pressure distribution is displayed in the figure below. Scroll the wheel
button of the mouse to zoom in or out to get a better view.

[KN/m?]
-170.00
-160.56
-151.11
-141.67
-132.22
-122.78
-113.33
-103.89
-94 44
-85.00
-75.56
-66.11
-56.67
-47.22
-37.78
-28.33
© -18.89
-9.44
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Figure 26: Preview of the steady state pore pressures in Phase_4 in a cross section
27. Change the legend settings to:

e Scaling: manual
¢ Maximum value: 0
¢ Number of intervals: 18
28. Click on the Close button to return to the Input program.

29, =
@ Add another phase (Phase_5). The default values of the parameters will be used for this calculation

phase.
30. Activate the surface load and set 6, = -20 kN/m?.
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B

6.1 Execute the calculation

efore starting the calculation process, some stress points next to the excavation pit and loading are selected to

plot a stress strain curve later on.

1.

~

-

Click the Select points for curves button L
The model and Select points window will be displayed in the Output program.

. Define (37.5 19 -1.5) as Point-of-interest coordinates.

Note: The visualization settings can be changed from the menu. For more information refer to Reference
Manual.

Click the Search closest button.
The number of the closest node and stress point will be displayed.

Click the checkbox in front of the stress point to be selected.

The selected stress point will be shown in the list.

Select also stress points near the coordinates (37.5 19 -5), (37.5 19 -6) and (37.5 19 -7) and close the Select
points window.

Click the Update button to close the Output program.

. Start the calculation process.

8.
H Save the project when the calculation is finished.

N

ote:

Instead of selecting nodes or stress points for curves before starting the calculation, points can also be
selected after the calculation when viewing the output results. However, the curves will be less accurate since
only the results of the saved calculation steps will be considered.

To plot curves of structural forces, nodes can only be selected after the calculation.

Nodes or stress points can be selected by just clicking them. When moving the mouse, the exact coordinates
of the position are given in the cursor location indicator bar at the bottom of the window.

2.7 Results

After the calculations, the results of the excavation can be viewed by selecting a calculation phase from the
Phases tree and pressing the View calculation results button.

1

2

) Select the final calculation phase (Phase_5) and click the View calculation results button.

The Output program will open and will show the deformed mesh at the end of the last phase.

. The stresses, deformations and three-dimensional geometry can be viewed by selecting the desired output
from the corresponding menus. For example, choose the menu Stresses > Plastic points to investigate the
plastic points in the model.
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3. In the Plastic points window, select all the options except the Elastic points and the Show only inaccurate
points options.

Plastic points =

Failure paints

Tension cut-off points
Cap points

Cap + hardening points
Hardening points
Liquefaction points

[ Elastic points
[7] show only inaccurate points

Close

Figure 27: Plastic points window

The figure below shows the plastic points generated in the model at the end of the final calculation phase.

Plastic points

M Failure point [ Tension cut-off point
¥ Cap point 4 Cap + hardening point
A Hardening point ¥ Liquefied point

Figure 28: Plastic points at the end of the final phase

The graph will now show the major principal strain against the major principal stress. Both values are zero at
the beginning of the initial conditions. After generation of the initial conditions, the principal strain is still zero
whereas the principal stress is not zero anymore. To plot the curves of all selected stress points in one graph,
follow these steps:
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1. Right-click and select Add curve > From current project.
2. Generate curves for the three remaining stress nodes in the same way.

uﬂ Curve generation
Mormal
H-fxis Y-Axis

Stress point 14900 * <Soi_2_1> (37.178; 19.

- Deformations

[#- Deformations

-- Total cartesian strains E\\ Stresses
B Total strains -- Cartesian effective stresses
- Cartesian total stresses
) EI Principal effective stresses
2q
Azg+esdi2
Azq-€q02
By
AE p
[ Stresses q
Tmab
Invert sign Invert sign

CK

Stress point 14900 * <5ail_2_1> (37.178; 19,

Cancel

Figure 29: Curve generation window

The graph will now show the stress-strain curves of all four stress points.

100

o, ki)

Chart 1
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Stress point 14900 */Stress point 149
Stress point 13588 */Stress point 135
Stress point 13116 */Stress point 131}
Stress point 13420 */Stress point 134
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Figure 30: Stress - Strain curve

To see information about the markers, make sure the menu item View > Value i

24063 27063 300

ndication is checked and hold

the mouse on a marker for a while. Information about the coordinates in the graph, the number of the point in
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the graph, the number of the phase and the number of the step is given. Especially the lower stress points show a
considerable increase in the stress when the load is applied in the last phase.

Note:

¢ Tore-enter the Curve generation window (in the case of a mistake, a desired regeneration or a
modification), select the menu item Format > Curve settings. As a result the Curves settings window
appears, on which the Regenerate button should be clicked.

¢ The menu item Format > Chart settings menu may be used to modify the settings of the chart.

To create a stress path plot for stress node (37.5 19 -1.5) follow these steps:

1. Create a new chart.

2. Inthe Curves generation window, select node (37.5 19 -1.5) from the drop-down menu of the x-axis of the
graph and o'y, under Cartesian effective stresses.

3. Selectnode (37.5 19 -1.5) from the drop-down menu of the y-axis of the graph. Select ¢',, under Cartesian
effective stresses.

4. Click OK to confirm the input.

18

R\‘/ﬂ

o, i)

Chart 1
Stress point 14900 */Stress point 14900 =
4 ; ; ; ;

220 210 200 -180 180 70 160 -150 140 130 120 110 100 200 800 700 500

Figure 31: Vertical effective stress (',,) versus horizontal effective stress (0',,) at stress node located near (37.5 19
-1.5)
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